Kentico 9
1. Multilingual websites

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Setting up multilingual websites</td>
<td>4</td>
</tr>
<tr>
<td>1.1.1 Setting default languages for users and visitors</td>
<td>6</td>
</tr>
<tr>
<td>1.1.2 Configuring URLs for multilingual websites</td>
<td>6</td>
</tr>
<tr>
<td>1.1.2.1 Creating language selectors</td>
<td>10</td>
</tr>
<tr>
<td>1.1.3 Support for right-to-left languages</td>
<td>11</td>
</tr>
<tr>
<td>1.1.4 Defining culture-dependent workflow scopes</td>
<td>12</td>
</tr>
<tr>
<td>1.1.5 Allowing content editors to edit only specified language versions</td>
<td>13</td>
</tr>
<tr>
<td>1.2 Setting up a multilingual user interface</td>
<td>14</td>
</tr>
<tr>
<td>1.2.1 Working with resource strings</td>
<td>17</td>
</tr>
<tr>
<td>1.2.2 Creating site specific resource strings</td>
<td>19</td>
</tr>
<tr>
<td>1.2.3 Localizing text fields</td>
<td>19</td>
</tr>
<tr>
<td>1.3 Editing the content of multilingual websites</td>
<td>21</td>
</tr>
<tr>
<td>1.3.1 Comparing language versions</td>
<td>23</td>
</tr>
<tr>
<td>1.3.2 Language status overview</td>
<td>23</td>
</tr>
<tr>
<td>1.4 Configuring translation services</td>
<td>25</td>
</tr>
<tr>
<td>1.4.1 Configuring content for translation</td>
<td>25</td>
</tr>
<tr>
<td>1.4.2 Machine translation - Microsoft Translator</td>
<td>27</td>
</tr>
<tr>
<td>1.4.3 Machine translation - Google Translate</td>
<td>27</td>
</tr>
<tr>
<td>1.4.4 Human translation services - Translations.com</td>
<td>28</td>
</tr>
<tr>
<td>1.4.5 Human translation services - Email translation</td>
<td>28</td>
</tr>
<tr>
<td>1.4.6 Human translation services - Manual translation</td>
<td>31</td>
</tr>
<tr>
<td>1.5 Translating content using external services</td>
<td>32</td>
</tr>
<tr>
<td>1.5.1 Translating localization strings using machine translation</td>
<td>36</td>
</tr>
<tr>
<td>1.5.2 Managing standard (human) translation submissions</td>
<td>38</td>
</tr>
<tr>
<td>1.5.3 Importing completed human translations</td>
<td>39</td>
</tr>
<tr>
<td>1.6 Developing unique page templates for specific languages</td>
<td>40</td>
</tr>
<tr>
<td>1.7 Changing the date and time format</td>
<td>41</td>
</tr>
</tbody>
</table>
# Multilingual websites

## Content editors

<table>
<thead>
<tr>
<th>Editing the content of multilingual websites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn how to create new language versions of web pages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Translating content using external services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate pages using machine translation or send the pages through an automated process to professional translator agencies.</td>
</tr>
</tbody>
</table>

## Administrators

<table>
<thead>
<tr>
<th>Setting up multilingual websites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure your websites to use multiple languages and learn how to set up default cultures for users and visitors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting up a multilingual user interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable and configure multiple languages for the Kentico administration interface.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuring translation services</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want to translate your website content and localization strings using translation services (for example, Google Translate), you first need to configure the services.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Developing unique page templates for specific languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages usually have the same layout across different languages, but you can also create a unique layout and design for each language version.</td>
</tr>
</tbody>
</table>

## Developers

<table>
<thead>
<tr>
<th>Developing custom translation services</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the default translation services provided in Kentico are not enough, you can integrate with any other translation services.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Translating content via REST</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can utilize a REST service to retrieve and submit translations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customizing XLIFF export for translations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize the XLIFF files that are used for exporting and importing translation data.</td>
</tr>
</tbody>
</table>
Setting up multilingual websites

Kentico websites can host content in multiple languages (cultures). Multilingual websites have separate versions of pages for each language. The system allows you to automatically offer culture versions of the website to visitors based on various settings. Users can also switch between individual languages manually using a dedicated web part.

You can find a list of available cultures in the Localization application on the Cultures tab. All major cultures are provided by default. You can assign cultures to websites and then translate the content to the respective languages.

Multilingual user and administration interface
The administration interface of Kentico can also be multilingual. To learn more, refer to the Setting up a multilingual user interface chapter.

Setting up multiple cultures for websites

To add more cultures to a website:

1. Open the Sites application.
2. Edit ( ) your site.
3. Switch to the Cultures tab.
4. Click Add cultures.
5. In the selection dialog, choose the cultures you wish to use.
6. Click Select.

The cultures are now assigned to the website and editors can start translating pages.

The website uses the following cultures:

- [ ] English - United States
- [ ] French - France
- [ ] German - Germany

Open the Pages application. You can now switch between languages using the selector below the content tree.
Setting the default content culture

When you create a new website, you specify the default culture in the New site wizard. If you create a website based on a web template, the site uses the culture of the given web template. All default Kentico web templates use **English - United States** as their default culture.

You can modify the default culture settings of a website in:

- **Settings -> Content -> Default content culture**
- **Sites -> Edit a site -> Default content culture**

The two settings are interlinked. Values configured in one section are reflected in the other location.
Setting default languages for users and visitors
You can configure which language version the system displays to users when they arrive on the website.

Configuration for registered users

The website culture displayed to registered website users depends on each user's **Preferred content culture** setting.

Users can change this setting for their account:
- in the administration interface, on the **Details** tab of the **My profile** application
- on the live site via the **My account** web part

Website administrators can adjust the setting for users in the **Users** application (when editing users on the **General** tab).

Depending on this configuration, users either see the content in their preferred culture (if available), or in the website's default content culture (if set to **default**) or if the preferred culture is not available.

Note: The act of logging in does not change the currently selected culture, so the setting only has an effect if users are already logged in when they first reach the website (e.g. when using Windows authentication).

Configuration for anonymous visitors

You can also configure the default content culture that the website displays to anonymous visitors. This can be done separately for the main website domain and for individual domain aliases:

- **Sites -> edit a site -> General -> Visitor culture** - used for visitors accessing the website through a URL containing the main domain name.
- **Sites -> edit a site -> Domain Aliases -> edit an alias -> Visitor culture** - used for visitors accessing the website through a URL that contains the domain alias.

The values can either be set to one of the cultures available for the website, or to **Automatic**, in which case the **user's browser settings** are used (for example, in Internet Explorer, you can set the default language in **Tools -> Internet options -> General -> Languages**).

Setting the default language for specific domains

Using the **Visitor culture** settings of the site and its domain aliases (described in the section above), you can configure the system to use a different default language based on the current domain. For example, if you use the following domains:

- example.com (main domain)
- example.de (domain alias)
- example.fr (domain alias)

You can set English, German and French as the default cultures for the domain and domain aliases (respectively). Now, when a visitor arrives at **example.fr**, the website automatically displays its French content.

Refer to [Configuring URLs for multilingual websites](#) for additional information about cultures, domains and URLs.

Configuring URLs for multilingual websites

On multilingual websites, all language versions of a page use the same URL by default. This URL is based on the given page's alias path. For example, the home page always has the following URL: `/Home`

If you want to see the same page in French, you need to change the culture by entering the URL with an **appropriate query string parameter**: `/Home?lang=fr-fr`

Once the language is selected, the system stores the preferred culture code in the visitor's browser using a cookie. This means that the given visitor automatically sees the French version when returning to `/Home` or another translated page, even without any parameters in the URL.

Providing language selectors for website visitors

Having to type a URL with a query string manually would be inconvenient for visitors. You can provide a more friendly way for users to switch between cultures using the **Language data source web part**.

Enforcing separate domains for languages

Having a different **domain name** for each culture is a good way to let visitors know that the particular version of the site is intended for a certain language audience. It is also the best option for multilingual websites with regard to **Search engine optimization**.
For example, if the English version of your site is available under domain.com, the French version could use domain.fr and so on. This scenario uses a different countrycode top-level domain, but you can set any other domain name format, such as unique subdomains for each culture.

To implement domain separation based on languages:

1. Open the Sites application.
2. Edit (EDIT) your site.
3. On the General tab, select your website's primary language in the Visitor culture field.
   - This assigns the given language to the site’s main domain name.
4. Set up additional domain names for other languages as domain aliases on the Domain aliases tab.
   - Just like with the main domain, you can assign a language to each alias by selecting the matching culture in the Visitor culture field.

**Configuration requirements**

When setting up the Visitor culture of the site and its aliases, only assign each language to a single domain and do not use the (Automatic) value. Otherwise the system cannot determine with certainty which content culture to display.

Also make sure that your domain aliases do not use a Redirect URL leading to another domain name.

5. Open the Settings application.
6. Select the URLs and SEO category and enable the Force domain culture setting.
7. Click Save.

**Note:** You cannot use forced culture domains in combination with the language URL prefixes described in the next section.

The system now ensures the following:

- The default content culture is selected based on the domain name through which the website is opened.
- All page URLs (e.g. in navigation elements) are generated using the domain name to which the current content culture is assigned.
- When a user selects a different language through one of the language selection web parts, the system redirects the URL to the corresponding domain name.

**Authentication with multiple domains**

The user context is not carried over when switching between domains on the live site. If you are using standard Forms authentication, registered users who change the content culture while browsing need to log in separately on each language version of the website.

If this is a problem, you can work around it by implementing a single sign-on mechanism for all domains.

**Using language prefixes for URLs**

If you do not own a different domain name for each language version of the website, but still want to ensure unique URLs for each culture without adding query string parameters, you can use language prefixes. Language prefixes insert a subdirectory into the URL in format `<domain>/<language prefix>/<URL path>`, for example: `<domain>/fr-FR/Home`

To enable language prefixes, go to Settings -> URLs and SEO, and enable the Use language prefix for URLs setting.

**Note:** You cannot use language prefixes if the Force domain culture setting is enabled.
Unless you check the **Allow URLs without language prefixes** setting, the system automatically redirects all URLs without a language prefix to a corresponding URL that includes a language prefix (according to the current content culture).

If language prefixes are enabled, the language selection web parts used on your site generate links containing the appropriate URL prefix by default. If you wish to configure a specific web part to use links with the standard query string parameter, disable the web part’s **Use culture specific URLs** property. Please keep in mind that all other settings still apply, so the resulting URLs may be redirected.

Changing the language prefix text:

By default, the language prefix matches the culture code of the requested language. If a **culture alias** is set for the language, it takes precedence and the system uses the alias instead of the culture code. If you want to change the language prefix for a certain language, the best way is to set a culture alias.

For example, to change the language prefix for the French language to *France*:

1. Open the **Localization** application.
2. Select the **Cultures** tab.
3. Type `fr-fr` into the **Culture code** filter and click **Search**.
4. Edit (-padlock) the **French - France** culture.
5. Set the **Culture alias** property to *France*.
6. Click **Save**.

The system now displays the language prefix in URLs of French page as for example: `<domain>/France/Home`

Using a custom page URL path for different culture versions

Forcing culture domains or using language prefixes for URLs ensures that you have a different URL for every page culture version. You can use the following approach if the features described above are disabled or if you want different culture versions of pages to have different names in the URL path.

For example, if you want the French home page to have a different URL than the English version:

1. Open the **Pages** application, and select the Home page in the content tree.
2. Select the French language in the selector below the content tree.
3. Open the **Properties -> URLs** tab.
4. In the **Page URL path** section, check **Use custom URL path**.
5. Leave the **Standard URL or wildcard** option selected as the **Path type**.
6. Set the **Path or pattern** value to: `/frenchhome`
7. Click **Save**.
**Alias**

Page alias: *Home*

**Page URL Path**

Use custom URL path: ✔

Path type: ● Standard URL or wildcard
         ○ Route
         ○ MVC

Path or pattern: /frenchhome

**Extended properties**

URL extensions: □ Use custom URL extensions
To try out how the custom URL works, sign out and view the English version of the website. If you open the URL `<domain>/frenchhome`, the website automatically switches the culture to French and displays the French version of the home page.

By default, language selection web parts reflect custom URL paths for pages when generating links to the corresponding culture version. If you wish to disable this behavior for a specific web part and have it use links with the standard page URL, disable its **Use culture specific URLs** property.

You can also set **Page aliases** for pages dedicated to specific cultures. When the page is accessed through this type of alias, the system always opens it in the corresponding culture.

**Note**: You may encounter problems when using wildcards in URLs on multilingual sites. You can find more details and a possible solution on the **Wildcard URLs** page.

### Creating language selectors

To create a language selector on a page, use the Language data source web part in combination with a Basic repeater web part.

1. Place the **Language data source** web part on a page. The data source generates 'CultureCode', 'CultureName', and 'URL' (the URL is culture specific) fields.
2. Configure the web part and copy the value of the **Web part control ID** property.
3. Place the **Basic repeater** web part on the page and configure it.
4. In the **Data source name** property, paste the copied **Web part control ID** value from the data source web part.
5. In the **Content before** and **Content after** field, add the markup for the language selector. For example:

```html
<div class="language-selection">{% CurrentCulture %}</div>
<nav role="navigation">
  <ul class="language-items">
  </ul>
</nav>
```

6. Access the data source fields in the transformation. For example:

```html
{%
  cultureLocalizedName = CultureCode;
  return;
#{
  <li>
    <a title="{% cultureLocalizedName %}" href="{%HTMLEncode(URL) %}" >{% cultureLocalizedName %} </a>
  </li>

7. **Save & Close**.
8. **Style** the markup in the **CSS stylesheets** application.

The page now lists the available cultures. You can also create resource strings for specific culture codes and access them like this instead:
This will allow you to display custom culture names instead of culture codes. The Dancing Goat sample site uses the same approach to build its language selector.

Even though switching between languages using URL query string parameters is the default approach, it is not recommended for live production websites. Parameters make URLs more confusing and are not friendly toward search engines. Instead, you can configure the system to use one of the options described in Configuring URLs for multilingual websites.

**Support for right-to-left languages**

If the website is displayed in a language that uses right-to-left direction of written text (typically arabic languages), the RTL CSS class is automatically assigned to the `<body>` element of all pages (<body class="RTL">). You may need to add right-to-left specific CSS style modifications to the stylesheet.

**RTL in content culture vs. UI culture**

The direction of website content is determined by the **Preferred content culture** setting of users.

The direction of the Kentico administration interface depends on the **Preferred user interface culture** setting of users. Currently, right-to-left languages are not fully supported in the administration interface.

**Renaming the language selection parameter**

The default name of the language selection parameter is `lang`. To rename the parameter:

1. Add the `CMSLanguageParameterName` key into the `/configuration/appSettings` section of your application's `web.config` file.
2. Enter the new name as the key's value.

```xml
<add key="CMSLanguageParameterName" value="sprache" />
```

Example:

**Original LTR style:**

```css
.xxx
{
    text-align: left;
    float: left;
    border-right: solid 1px #cccccc;
}
```

**RTL style:**
Adding culture-specific fonts to the editor

If your culture uses specific fonts that are not available in the WYSIWYG editor, you need to add the fonts:

1. Edit the `<web project>/CMS/CMSAdminControls/CKeditor/config.js` file.
2. Set the list of available fonts through the `config.font_names` property. For example:

   ```javascript
   // Leaves the default set of fonts and adds 'Calibri' to the options
   config.font_names = 'Arial;Calibri;Comic Sans MS;Courier New;Georgia;Lucida Sans Unicode;Tahoma;Times New Roman;Trebuchet MS;Verdana';
   ```

3. Save the file.
4. Clear the cache of your web browser.

Log in to the Kentico administration again. You should see the new fonts in the editor's font list.

**Note:** Many of the default editor toolbars do not contain the Font selector by default. To learn how to add the selector to individual toolbars, see Personalizing the editor toolbars and buttons.

Defining culture-dependent workflow scopes

Workflows can be defined separately for each language version of your pages by using culture-dependent workflow scopes. A workflow scope determines which pages are affected by a particular workflow.

To learn how to create workflows and workflow scopes, refer to the Configuring workflows chapter.

The system applies workflow scopes with the following priority (from highest to lowest):

1. Scopes with a specified page type and culture
2. Scopes with a specified page type
3. Scopes with a specified culture
4. Scopes without a specified page type and culture
Allowing content editors to edit only specified language versions

The system allows you to specify which language versions of pages users are allowed to edit.

1. Open the Users application.
2. Edit (ﾳ) the user.
3. Switch to the Languages tab and select one of the following options:
   - User can edit all languages - the user can edit pages in any language.
   - User can edit following languages - you can choose which language versions the user can edit. The Select site list allows you to configure the language bindings for specific websites.
Setting up a multilingual user interface

The user interface culture determines the language of the Kentico administration interface, as well as other factors like numeric and date formats.

Managing site cultures

You can manage all cultures in the Localization application on the Cultures tab. To display only UI cultures, choose Yes in the Is UI culture filter and click Search.
When you create a new culture or edit an existing culture, you can define the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Culture name</td>
<td>Name displayed for the culture in the administration interface.</td>
</tr>
<tr>
<td>Culture code</td>
<td></td>
</tr>
<tr>
<td>Culture short name</td>
<td></td>
</tr>
<tr>
<td>Culture alias</td>
<td></td>
</tr>
</tbody>
</table>

When you create a new culture or edit an existing culture, you can define the following properties:

<table>
<thead>
<tr>
<th>Action</th>
<th>Culture name</th>
<th>Culture code</th>
<th>Culture short name</th>
<th>Culture alias</th>
<th>Is UI culture</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Afrikaans - South Africa</td>
<td>af-ZA</td>
<td>Afrikaans</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Arabic - Iraq</td>
<td>ar-IQ</td>
<td>Arabic</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Czech - Czech Republic</td>
<td>cs-CZ</td>
<td>Czech</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>English - New Zealand</td>
<td>en-NZ</td>
<td>English</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>English - United States</td>
<td>en-US</td>
<td>English</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>French - France</td>
<td>fr-FR</td>
<td>French</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>German - Germany</td>
<td>de-DE</td>
<td>German</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Turkish - Turkey</td>
<td>tr-TR</td>
<td>Turkish</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Preparing UI cultures

Kentico allows you to manage content in any language, including double-byte (eastern) languages, such as Chinese. All content is stored and published in UNICODE.

To prepare the system to display the administration interface in a different language or at least with different culture settings (e.g. calendar and numeric format):

1. Open the Localization application.
2. Select the Cultures tab.
3. Edit (✔) the culture you want to use for the administration interface.
4. Select the Is UI culture check box.
5. Click Save.

Users can now select the new culture as their default UI culture in the My profile application using the Preferred user interface culture drop-down list. However, if the system does not have a corresponding language pack installed, the administration interface strings will still be displayed in the default language.

Installing downloaded localization packs

Kentico provides only a few selected language packs for the user interface texts with the standard installation. You can find these packs as .resx files in the ~\CMS\CMSResources folder. However, you can download localization packs with already translated resource files for some selected languages from DevNet.

After downloading a package:

1. Open the package and copy the .resx file into the ~\CMS\CMSResources folder.
2. Restart the application to apply the changes to the user interface:
   a. Open the System application.
   b. Click Restart application.

Translating localization strings manually

To translate the localization strings for the added UI culture into a different language manually:

1. Create a copy of the ~\CMS\CMSResources\cms.resx file in the same folder and name it cms.<culture code>.resx (for example, cms.he-IL.resx).
   a. This file now stores strings with the text of the administration interface copied from the original culture.
2. Open the copied file and translate the localization strings.
3. After modifying the .resx file, restart the application to apply the changes to the user interface:
   a. Open the System application.
   b. Click Restart application.

Setting the default UI culture

The default UI culture is en-us. If you configure the system to allow more UI cultures to be used, you can change the default UI culture for users by adding the following key to the <appSettings> section of your site’s web.config file:

```xml
<add key="CMSDefaultUICulture" value="en-nz" />
```

The value of this key must be a valid culture code (in the example above, en-nz represents the English - New Zealand culture).

If you wish to change the default UI culture, you also need to rename the ~\CMS\CMSResources\CMS.resx file to CMS.en-us.resx and the CMS.en-nz.resx file to CMS.resx. This is needed because the CMS.resx file is used when the (default) option is selected as a
When the above mentioned key is used and the CMS.resx file contains the en-nz dictionary, the UI culture will be en-nz for users who have their Preferred user interface culture set to (default).

### Applying a culture to a specific user’s UI

You can set the administration interface to a specific culture for each user in the system:

1. Open the Users application.
2. Edit the user.
3. Select the required Preferred user interface culture on the General tab.
4. Click Save.

Users may also select their own user interface culture in the My profile application on the Details tab, by setting the Preferred user interface culture.

When the user signs out and then back in, the system displays the interface according to the new culture settings and with translated strings (once the translation is complete).

Users can also change the culture of their interface by opening the User menu and clicking on Change language. This selection also changes the Preferred user interface culture setting of the given user.

### Working with resource strings

Resource strings store the text displayed in the Kentico administration interface (and on the live site in some cases).

- All default resource strings are stored in the cms.resx file, which is located in the project's CMSResources folder.
- You can define site specific resource string files, as described in Creating site specific resource strings.
- To create resource string files for custom modules, see an example in Example - Creating a packageable module.
- You can edit the resource strings that the system stores in the database in the Localization application on the Resource strings tab.

#### Resource string priority

When loading resource strings, the system uses the following priority:

1. database (Localization application) – highest priority
2. site specific resx files
3. resx files of custom modules
4. custom.resx
5. cms.resx

If there are duplicate strings with the same key in all five sources, the system uses the one stored in the database.

To change the priorities, you can add the following key to your web.config:

```xml
<add key="CMSUseSQLResourceManagerAsPrimary" value="false" />
```

When this key is added, the priorities are as follows:

1. site specific resx files
2. resx files of custom modules
3. custom.resx
4. cms.resx
5. database

### Modifying the default UI strings

If you want to modify text in the user interface (including web part dialogs), you can create a custom.resx file and store your strings in this file. The keys used to identify the strings must be the same as in cms.resx file. This procedure allows you to modify the strings without worrying that your changes will be overwritten during an upgrade to a newer version.

If you need to customize strings in a non-English resource file, your custom file must use a name like custom.<culture code>.resx (for example, custom.fr-fr.resx for French).

### Adding your own strings
If you need to translate custom strings used on your website such as form labels, display names of objects or other static text into other languages, you can create a new resource string:

1. Open the Localization application.
2. Choose the default culture in the Culture selector.
3. Click New string.
4. Type the name of the resource string into the Key field.
5. Type the text for the key into the Translation field of the corresponding language.
6. Click Save.

A new string in the default culture is now displayed in the list.

You can also create new resource strings directly when editing text fields in the administration interface. See Localizing text fields.

Translating resource strings into other languages

1. Open the Localization application.
2. Edit ( ) the resource string.
3. If you do not see the desired language, use the Show translation for radio buttons to change the category of cultures.
4. Translate the string into the desired language in the corresponding Translation field.

5. Click Save.
The resource string and its translation are now created and stored in the database.

**Loading resource strings in the API**

If you need to retrieve the value of a resource string in your custom code, use the `CMS.Helpers.ResHelper.GetString` method.

```csharp
using CMS.Helpers;
...

// Loads the value of the 'stringKey' resource string (in the default culture)
string localizedResult = ResHelper.GetString("stringKey");
```

**Creating site specific resource strings**

All default resource strings are stored in the `cms.resx` file, which is located in the project's `CMSResources` folder. However, you can also create site specific resource strings and have different strings for each of your website. See Working with resource strings to see which resource string files have higher priority than others.

Site specific resource strings cannot be edited from Kentico administration interface, only through the created resx files.

To create site specific resource string files:

1. Open your Kentico project in Visual Studio.
2. Open the `App_Data -> <siteName> -> Resources` (or `CMSApp -> App_Data -> <siteName> -> Resources in web application projects`) folder.
3. Create a folder named according to the code name of the desired culture (for example `cs-CZ`).
   - Such folders will store resx files for the specified cultures.
4. Right-click the created culture folder to create a culture specific file and select `Add -> New Item`.
   - If you right-click the `Resources` folder and select `Add -> New Item`, you can create a resx file for the default culture.
5. Create a file with an arbitrary name with the `.resx` extension.

The system creates a file with the resource string template (allows adding pairs of resource string Names and Values).

You can now add pairs of resource string names and values which you want to be defined specifically for the site, for example:

- **Name**: `mysite.logonform.username` (the recommended format is `siteCodeName.stringName`)
- **Value**: `User name:

This resource string changes the header of the message displayed on the dashboard in Kentico administration interface.

**Localizing text fields**

Fields in the Kentico administration interface that contain the Display names or Descriptions of objects provide a user friendly way to handle localization. This is achieved using action buttons and dialogs that allow you to insert resource strings and edit their text and translations directly.

To add a resource string to a field where localization is supported:

1. Place the cursor into the field and click the **Localize (†)** button.

2. Choose from the two options:
   - **Create new resource string** - directly creates a new resource string. The identifier (key) of the new string contains a special prefix (custom. by default).
   - **Use existing resource string** - allows you to select an existing resource string. You can choose only strings that are stored
in the database. Resource strings contained in .resx files cannot be accessed this way.

3. Type the resource key name into the displayed dialog or choose an existing resource key.
4. Click Save & Close.
5. Edit the text of the resource string for individual cultures.
   - You can use machine translation services to assist with the translation (if there are any configured for your application).
   - If you do not see the desired language, use the Show translation for radio buttons to change the category of cultures.
   - Please keep in mind that modifying an existing resource string also affects all other occurrences of the same string.

6. Click Save & Close to confirm any changes made to the resource string.
7. Save the editing form to confirm the insertion of the string into the field.

The field is now localized and displays a value according to the current culture settings. You can edit the text of the resource string at any time by clicking Localize other languages (/fontawesome.fa.fa-plus) or directly in the form.

To remove the localization string from a field, click Remove localization (fa fa-minus).

Note: Resource strings created using localization dialogs are always stored in the database. The dialogs cannot be used to interact with strings contained in resource files (.resx) under the CMSResources folder.

Localizing text fields using macro expressions

If you need to supply a localized value into a field or text area where localization expressions are supported, you can use expressions in the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic format:</td>
<td>Displays the value of the resource string with the specified key. Strings can be viewed and edited in the Localization application or in the .resx files under the CMSResources folder.</td>
<td>{$myform.firstname$}</td>
</tr>
</tbody>
</table>
In-place localization:

\[\text{\$=default_string\|culture_code=translation|culture_code=translation|etc.\$}\]

Displays the strings defined in the expression.

\[\text{\$=Hello\|de-de=Hallo\|it-it=Ciao\$}\]

See also: Macro expressions

---

**Editing the content of multilingual websites**

After the site administrator has specified cultures for a website, the content editors can begin to translate the content (web pages) or assign the translation to translation services.

When you open the Pages application on a multilingual website, you can see the language selector below the content tree. Use the selector to switch between language versions of the currently selected page.

You can also click Compare to edit language versions side-by-side.

**Creating multiple language versions of pages**

The following example shows how to manually translate a page into the French language:

1. Open the Pages application.
2. Select the root page in the content tree and switch to the French culture. Since the French version of the page does not exist yet, you can create it through one of the following ways:
   - **Create empty page** - creates a new page of the same type, but without any content.
   - **Copy content from another language** - creates a copy of the page with content loaded from the selected language version. If Save the new page before editing is checked, the system adds the new page version and immediately saves the copied content.
   - **Translate using translation service** - with this option, the content of the page's new language version will be provided by an external translation service. See the Configuring translation services chapter to learn more.
3. Choose to **Copy content from another language**.
4. Select **English - United States**.

5. Click **Create page**.

The French version of the root page has now been created. You can now translate other pages on the website:

1. Choose the **Home** page in the content tree.
2. Select **Copy content from another language**, but this time disable the **Save the new page before editing** option.
3. Click **Create page**.
4. The editing form of the new page version opens. Change the **Page name** to **French Home**.
5. Click **Save**.
6. On the **Page** tab, change the text of the heading in the second editable region to: **Welcome to the French version of the sample Corporate Site**
7. Click **Save**.

You can modify the content of a page's editable regions to be different for each specific language version. It is also possible to translate the content entered on a page's **Form** tab, and even assign culture specific values for many of the page's **Properties**.

If you view the page on the live site, you can see the French version.

---

You can switch between languages using the language selection links at the top right of the website header.

---

**Creating content for another language**

When adding a new language to the website, please be sure to always create a language version for at least the **root page** and the default **home page**. Otherwise, the system cannot display the site correctly.
Using the default language version for untranslated pages
You can configure websites to display content from the default language for pages that are not available in the selected language.

1. In the Kentico administration interface, open the Settings application.
2. Select the Content category.
3. Choose your Site enable the Combine with default culture setting.
4. Click Save.

Now you can sign out and view the French version of the live website again. Pages that are not available in French are displayed in the default culture (English).

Comparing language versions
Language version comparison enables content editors to view and edit two different language versions of pages side-by-side. This can be convenient when translating website content into multiple languages.

To switch to language version comparison mode in the Pages application, select a page and click Compare below the content tree.

The system displays a language version comparison toolbar and splits the page editing area below the toolbar into two parts:

- The first displays the page in the language selected in the main selector below the content tree.
- The second displays the language selected on the comparison toolbar.

You can edit both displayed language versions independently at the same time.

The language comparison toolbar provides the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close comparison mode</td>
<td>Closes the comparison mode and returns to the standard view of a single language version. You can also close the comparison by clicking Compare below the content tree again.</td>
</tr>
<tr>
<td>Vertical layout</td>
<td>Splits the editing area vertically.</td>
</tr>
<tr>
<td>Horizontal layout</td>
<td>Splits the editing area horizontally.</td>
</tr>
<tr>
<td>Synchronize scrollbars</td>
<td>If enabled, scrollbars in both parts of the editing area are synchronized, resulting in the same sections of both language versions being displayed while scrolling.</td>
</tr>
<tr>
<td>Language selector</td>
<td>You can choose which language version of the page is compared with the selected language.</td>
</tr>
</tbody>
</table>

- If you select a page whose version in the comparison language is not created yet, the standard New culture version dialog appears.
- Language version comparison mode is available in both Edit and Preview mode.
- The comparison mode is also supported for page Properties, except for the Linked pages, Related pages, Security and Languages tabs (the page properties on these tabs are shared by all language versions).

Language status overview
The Listing mode of the Pages application provides an overview of page language versions.
If you select a page in the content tree and switch to **Listing** mode, you can see all child pages.

The **Languages** column displays flags with differently colored backgrounds for all languages available on the website. The flags represent particular language versions of pages and indicate the following statuses:

- **Green - Translated** - the page is available in the given language and up-to-date. The actual language of the page's content has no effect on the status, the system only checks whether the language version exists.
- **Orange - Outdated** - the language version exists for the page, but is outdated. The system considers language versions to be outdated if the default language version of the page has been modified (or published when using workflow) more recently.
- **Red - Not available** - the page does not exist in the given language. You can also see the **A** icon next to pages in the content tree.

The **Waiting for translation** status indicates that the page exists in the given language, but its content has not been translated yet. The page's content is currently submitted to a translation service.

You can manage the translation submission in the **Translations** application.

Clicking a **Translated** or **Outdated** flag opens the **Page** tab of the appropriate language version of the page. If you click a **Not available** flag, the language version’s creation dialog opens.

The **Name** column displays the names of the pages in the currently edited culture. If the page version **does not exist** in this language, the column displays the name from the **default culture**.

You may also view the language statuses separately for individual pages. To do so, select a page in the content tree in the **Pages** application and switch to the **Properties -> Languages** tab. Here you can also use the following actions for individual language versions:

- **Edit culture** - switches the Pages application to the given language.
- **Create new culture version** - shown for languages in which the page is not available. Clicking the action creates a new version of the page in the given language.
- **Translate page** - opens a dialog where you can submit the page for translation to the given language, using a specified translation service.

---

<table>
<thead>
<tr>
<th>ID</th>
<th>Actions</th>
<th>Name</th>
<th>Page type</th>
<th>Children</th>
<th>Modified</th>
<th>Published</th>
<th>Version</th>
<th>Languages</th>
<th>Personas</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>Home</td>
<td>Page (menu item)</td>
<td>No</td>
<td>7/25/2014 10:08:33 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Products</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>7/23/2014 16:08:37 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>News (en-US)</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>6/5/2014 16:08:32 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Partners</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>7/23/2014 10:08:42 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Community (en-US)</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>6/30/2014 10:08:44 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Services</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>7/23/2014 10:08:46 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Company</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>7/23/2014 10:08:49 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Media</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>7/23/2014 10:08:53 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Examples (en-US)</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>2/19/2014 12:26:33 PM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Mobile (en-US)</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>9/6/2012 16:50:16 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Other (en-US)</td>
<td>Page (menu item)</td>
<td>Yes</td>
<td>4/13/2011 16:50:16 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>Special Pages (en-US)</td>
<td>Folder</td>
<td>Yes</td>
<td>6/27/2011 10:27:25 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>Images (en-US)</td>
<td>Folder</td>
<td>Yes</td>
<td>6/27/2011 10:37:48 AM</td>
<td>Yes</td>
<td>-</td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
<td><img src="#" alt="Green" /> <img src="#" alt="Green" /></td>
</tr>
</tbody>
</table>
Hiding the Languages tab

The Languages tab can be displayed or hidden for members of particular roles. This can be set up using UI personalization.

Configuring translation services

You can automate or outsource the translation of website content using translation services. Translation services allow you to create multilingual sites without having to edit the text in the Kentico administration interface. The system automatically ensures the transfer of data between the website's pages and translation providers. Translation data is exported and imported via files using the standard XML-based XLIFF format.

There are two general categories of translation services:

- **Machine services** - use translation software to programatically convert source text from one language to another. By default, Kentico supports the Microsoft Translator and Google Translate. See Machine translation - Microsoft Translator and Machine translation - Google Translate.

- **Standard services (human translation)** - provide an automated interface between Kentico and external human translators. By default, you can use the Translations.com service. See Human translation services - Translations.com.

You can also develop custom services.

The main purpose of translation services is to create language versions of the website's pages based on the content in another language.

Enabling translation services

To enable the translation service functionality:

1. Open the Settings application.
2. Select the Content -> Translation services category.
3. Check Enable translation services.
4. Click Save.

Translation services settings

You can find the settings related to translation services in the Settings application within the Content -> Translation services category. For each translation service you intend to use on your website, you have to configure the corresponding settings.

Managing translation services

You can manage translation services in the Translation services application.

For creating new translation services, see Developing custom translation services.

Configuring content for translation

Translation services can process the following types of page content:

- Content of editable regions
- Values of page fields (entered on the Form tab of the Pages application)
- The properties of web parts placed on the given page
- Page file attachments

The system allows you to specify exactly which parts of the content are translated. These settings affect all types of translation services.
Configuring page fields

To choose which page fields are sent for translation, adjust the form definition of individual page types:

1. Open the Page types application.
2. Edit ( ✔️) a specific page type.
3. Switch to the Fields tab.
4. Select the field that you wish to configure and enable or disable the Translate field flag. Translation is only available for fields with the Text, Long text or File Data type.
5. Click Save to confirm the changes to the field.

When users submit pages of the given type for translation, only the content of fields that have the Translate field flag enabled is included in the translation.

Configuring web part content

Pages may also contain text added via Web parts and Widgets. The only way to translate web part content is to localize the values of the corresponding web part properties. You can configure the system to automatically include specific web part properties in translations. This is only recommended for web parts that directly add text onto the page (such as Static text).

1. Open the Settings application and select the Content -> Translation services category.
2. Enable the Translate web part properties setting.
3. Click Save.
4. Open the Localization application and select Cultures tab.
5. Enable the Is UI culture flag for all content languages that you use on your website (see Setting up a multilingual user interface).
6. Open the Web parts application.
7. Select the appropriate web part and open the Properties tab.
8. Enable or disable the Translate field flag for individual properties.
   - Translation is only available for properties that use the Text, Long text or File Attribute type.
   - Click Save for every modified property.

If a page that contains the given web part is submitted for translation, the system includes the values of all properties that have the Translate field flag enabled. When importing the translation, the system creates a resource string for every translated property, containing the value in the target language. The original text values of the properties are replaced by localization macros, which insert the appropriate resource strings.

Allowing translation of page attachments

Human translation services allow users to submit file attachments for translation along with the main content of pages. To configure
attachment translation for your website:

1. Open the **Settings** application and select the **Content -> Translation services** category.
2. Enable the **Allow attachment translation** setting.
3. Specify which types of files should be translated using the **Translation attachments file types** setting.
   - Enter a list of all allowed file extensions separated by semicolons (for example: `txt;docx;pdf`). Leave the setting empty to allow translation for all types of attached files.
4. Click **Save**.

Users can check the **Translate attached files** option when submitting pages for translation, and the system adds all allowed file attachments into the translation source. When the completed translation is imported, the translated file is attached to the appropriate language version of the page.

### File format

The system adds file attachments directly into the XLIFF translation source as binary data encoded in Base64 format.

---

**Machine translation - Microsoft Translator**

This service uses the Microsoft (Bing) Translator API to translate text. Microsoft Translator offers a free subscription for up to 2 million characters per month, higher editions must be purchased.

#### Character limit

This service has a 2000 character limit for every translation request. When translating pages, the service submits the content of every field and editable region as a separate unit, so the total number of characters per page is not restricted.

**Configuring the Microsoft Translator service**

To set up the Microsoft Translator service on your website:

1. Sign up for a subscription to the Microsoft Translator on the [Windows Azure Marketplace](https://www.windowsazure.com). You need to create a Windows Live ID account if you do not already have one.
2. Register your website as an application on the [Azure DataMarket](https://datamarket.azure.com).
3. Log in to the Kentico administration interface and open the **Settings** application.
4. Select the **Content -> Translation services** category.
5. Enter the **Client ID** and **Client secret** of your application into the corresponding settings in the **Microsoft Translator** section.
6. Click **Save**.

You can now translate pages and localization strings using the Microsoft Translator service.

---

**Machine translation - Google Translate**

This service uses the [Google Translate API](https://translate.googleapis.com/translate_api.html) to translate text. Google Translate is a paid service.

#### Character limit

This service has a 2000 character limit for every translation request. When translating pages, the service submits the content of every field and editable region as a separate unit, so the total number of characters per page is not restricted.

**Configuring the Google Translate service**
To set up the Google Translate service on your website:

1. Sign in to the Google APIs console using a Google account.
2. Create a new project and activate the Translate API service.
3. Obtain your project's API key on the API Access pane.
4. Log in to the Kentico administration interface and open the Settings application.
5. Select the Content -> Translation services category.
6. Copy the API Key into the corresponding setting in the Google Translator section.
7. Click Save.

You can now translate pages and localization strings using the Google Translate service.

Human translation services - Translations.com

Translations.com is a worldwide translation provider that offers website localization in over 170 languages. Kentico includes a default service that automatically ensures the transfer of translation data between the system and Translations.com.

To set up the Translation.com service:

1. Contact a Translations.com representative and arrange a translation project for your website.
2. Log in to the Kentico administration interface and open the Settings application.
3. Select the Content -> Translation services category.
4. Fill in the information of your Translation.com project into the settings under the Translations.com section:
   - Project Director URL
   - Client user name
   - Client user password
   - Project short code
5. Click Save.

You can now submit pages for translation using the Translations.com service.

Translation submission logs

Whenever a user submits a translation to Translations.com, the system creates a record in the event log (Event log application). The service also logs any errors that may occur while sending or receiving translation data.

Human translation services - Email translation

The Email translation service delivers the translation data via email. When a user submits a page for translation, the service creates a zip package containing the XLIFF source files and sends it to the specified translators as an attachment of an email message. The email service allows you to exchange data with translators or agencies that do not have their own API for managing submissions.

The system cannot cancel email translation submissions once they have been sent. In these cases, you need to contact the translators directly.

The email translation service does not support automatic retrieval of completed translations. The translators can submit the files by:

- Uploading the zip archive containing the finished translation via a link included in the original assignment email
- Sending the translation (in XLIFF format) to a member of the website's staff, who can then import it manually through the Translations application.

Once the translation is imported into the corresponding submission, you can process it to transfer the new content into the pages.

Note: Email translation uses the Translation services - Submit translation email template. The service does not work if you delete this template (a template with the code name translationservice.submittranslation must exist in the system).

Configuring the email translation service

To set up the email translation service:

1. Ensure that your application is configured to send emails through an appropriate SMTP server.
2. Open the Settings application.
3. Select the **Content -> Translation services** category.
4. Fill in the following settings in the **Translation via email** section:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation submission recipients</td>
<td>Sets the addresses to which the system sends translation assignments through the email service. You can enter multiple email addresses separated by semicolons.</td>
</tr>
<tr>
<td>Email sender</td>
<td>When sending translation assignment emails, the system automatically sets the sender to the address of the user who submitted the translation. The value of this setting is used if no user address is available, for example in the case of translations submitted automatically or via the API.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

The service sends the translation emails using the specified addresses.

**Setting language-specific recipients**

If you need to assign different translator addresses for individual languages:

1. Open the **Translation services** application.
2. Create a clone of the **Translation via email** service for each additional language. Click **Other actions (…)** next to the service and select **Clone** in the menu.
3. Edit the services and enter the appropriate translator addresses into the **Translation submission recipients** property. This property overrides the **Email sender** setting.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Translation via e-mail - French</td>
</tr>
<tr>
<td>Code name</td>
<td>EmailTranslationService_French</td>
</tr>
<tr>
<td>Service provider</td>
<td>CMS.TranslationServices</td>
</tr>
<tr>
<td>Assembly name</td>
<td>CMS.TranslationServices.EmailTranslationService</td>
</tr>
<tr>
<td>Class</td>
<td></td>
</tr>
<tr>
<td>Is machine translation service</td>
<td>False</td>
</tr>
<tr>
<td>Service is enabled</td>
<td>True</td>
</tr>
</tbody>
</table>
When submitting pages for translation, users need to select the clone of the email translation service that matches the target language.

Customizing the translation emails

To change the content of the email messages that the service sends to translators, you need to modify the appropriate email template:

1. Open the Email templates application.
2. Edit the Translation services - Submit translation template.
3. Alter the template according to your specific requirements.
   - You can use macro expressions to dynamically insert the values of the given translation submission. For example:
     - `{% Submission.SubmissionSourceCulture %}` - returns the culture code of the translation source language.
     - `{% Submission.SubmissionTargetCulture %}` - returns the culture code of the target language.
     - `{% GetTranslationPriority(Submission.SubmissionPriority) %}` - returns the priority set for the submission (low, normal or high).
     - `{% Submission.SubmissionDeadline %}` - returns the date and time of the submission's deadline.
     - `{% Submission.SubmissionInstructions %}` - returns the additional instructions entered for the submission.
     - `{% Submission.WordCount %}` - returns the total number of words in the translation source text.
     - `{% SubmissionLink %}` - returns the URL of a system page where users can upload finished translation packages.
4. Click Save.
5. (Optional) Follow the steps described for the manual translation service if you wish to customize the instruction files included in the zip package attached to the emails.

The service sends all translation assignment emails based on the current email and instruction file templates.

Human translation services - Manual translation

The manual service exports the translation data onto the file system. Every translation submission is converted to a zip archive containing .xlf files (the source data in XLIFF format) and instructions. You can deliver the translation assignment by:

- Sharing the export folder
- Manually sending the submission package to the translators (the default folder is `~/App_Data/Translations/Export/`)

The service checks for finished translations in a designated import folder. The translators can also manually upload the completed zip package through a system page (the default instructions in the translation package provide a link).

Important!
The package containing the completed translation must have the same names as the original source package for all .xlf files and the parent zip archive. The system uses the names as identifiers when importing the translated data.

Configuring the manual translation service

To set up the manual translation service, open the Settings application, select the Content -> Translation services category and configure the settings in the Manual translation section:
### Setting & Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation submission export folder</td>
<td>Specifies the path of the folder where the service creates the zip packages with the translation source data (XLIFF files and instructions). If empty, the ~/App_Data/Translations/Export/ folder is used.</td>
</tr>
<tr>
<td>Translations import folder</td>
<td>Sets the path of the folder from which the system imports zip packages containing completed translations. If empty, the ~/App_Data/Translations/Import/ folder is used.</td>
</tr>
<tr>
<td>Delete ZIP after successful download</td>
<td>If enabled, the system deletes the zip packages containing finished translations after importing the XLIFF data.</td>
</tr>
</tbody>
</table>

#### Customizing the instruction files

In addition to the .xlf files that store the translation source data, the manual translation service places instruction files into the exported zip packages. The instruction files are created as copies of template files found in the ~/App_Data/CMSModules/Translations/Template/ folder under your web project.

By default, the folder contains the Instructions.html file. You can modify the content of this file according to your own requirements and even add additional instruction files that the service will include in the zip packages.

You can use macro expressions in the text of instruction files to dynamically insert the values of the given submission. For example:

- `{% Submission.SubmissionSourceCulture %}` - returns the culture code of the translation source language.
- `{% Submission.SubmissionTargetCulture %}` - returns the culture code of the target language.
- `{% GetTranslationPriority(Submission.SubmissionPriority) %}` - returns the priority set for the submission (low, normal or high).
- `{% Submission.SubmissionDeadline %}` - returns the date and time of the submission's deadline.
- `{% Submission.SubmissionInstructions %}` - returns the additional instructions entered for the submission.
- `{% Submission/SubmissionWordCount %}` - returns the total number of words in the translation source text.
- `{%SubmissionLink%}` - returns the URL of a system page where users can upload finished translation packages.

#### Translating content using external services

You can automate or outsource the translation of website content using translation services. The system automatically ensures the transfer of data between the website’s pages and translation providers. Translation data is exported and imported via files using the standard XML-based XLIFF format.

There are two general categories of translation services:

- **Machine services** - use translation software to programmatically convert source text from one language to another. By default, Kentico supports Microsoft Translator (Bing) and Google Translator.
- **Standard services (human translation)** - provide an automated interface between the system and external human translators. By default, Kentico supports Translations.com, E-mail translation and Manual translation.

The main purpose of translation services is to create language versions of the website’s pages based on the content in another language. There are several different ways to submit pages for translation.

You can integrate page translation via services into your workflow process. Advanced workflow offers action steps that allow you to automatically manage page translations.

There are two predefined workflows (in the Workflows application) that you can configure and apply to your website:

- **Translation - Default language version** - automatically sends pages for translation via a selected service when a user approves the default language version.
- **Translation - Import to other language versions** - periodically checks for translations completed by standard services and imports them into the appropriate pages when ready.

#### Requirements

- The Enable translation services setting must be enabled in Settings -> Content -> Translation services.
- The chosen type of translation service must be configured in Settings -> Content -> Translation services. See Configuring translation services.
- Your website needs to be configured for multiple content cultures, including all languages that you plan to use.

#### Translating pages to other languages

You can create new language versions of pages using a translation service in:
The Pages application
The Translations application - use this if you want to submit page translations and view the status of ongoing translation submissions in the same interface. Applies to standard services (Manual translation, E-mail translation, Translations.com) only.
Page listing - allows you to submit multiple pages for translation in a single operation.

Translating pages in the Pages application

1. Open the Pages application.
2. Select the page that you wish to translate in the content tree.
3. Switch to the target language using the selector below the content tree.
4. Select Translate using translation service.
5. Choose one of the available translation services. If you cannot see the desired option:
   a. Make sure the configuration is correct in Settings -> Content -> Translation services. See Configuring translation services for details on configuring translation services.
   b. (Translation.com, Microsoft Translator, and Google Translator service) Check the Event log application for incorrect credentials errors.
6. Fill in the details for the translation (some of the options may not be supported by the selected service):

<table>
<thead>
<tr>
<th>Translate from</th>
<th>If the page already exists in more than one language, you can choose which one the service uses as the source for the translation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human translation parameters</td>
<td></td>
</tr>
<tr>
<td>Translate attached files</td>
<td>Enable this option to submit the page's file attachments for translation along with the main content. The system adds file attachments directly into the XLIFF translation source as binary data encoded in Base64 format.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sets the priority of the translation (low, normal or high).</td>
</tr>
<tr>
<td>Translation deadline</td>
<td>Specifies a deadline date for the translation.</td>
</tr>
<tr>
<td>Instructions for translators</td>
<td>Here you can enter additional instructions for human translators.</td>
</tr>
</tbody>
</table>

7. Click Submit for translation.

The system adds the new language version of the page.

- Machine services immediately insert the translated content into the new page version.
- When using standard (human) translation services, the system initially creates the new page version as a copy of the source language. The content tree shows the Waiting for translation status icon ( ) next to pages in this state. You can manage the translation through a submission ticket in the Translations application. Once the service completes the translation, you can process the submission to transfer the new content into the appropriate language version of the page.
Creating submissions in the Translations application

You cannot use machine translation services (Google Translate or Microsoft Translator) in the submissions dialog. Translate pages using machine translation services directly in the Pages application.

1. Open the Translations application.
2. Click **Create new submission**.
3. Select the page that you want to translate. You can also type the path directly in the field.
4. Choose one of the available translation services.
   a. Make sure the configuration is correct in **Settings -> Content -> Translation services**. See Configuring translation services for details on configuring translation services.
   b. (Translation.com service) Check the **Event log** application for incorrect credentials errors.
5. Fill in the details for the translation (some of the options may not be supported by the selected service):

| Translate from | If the page already exists in more than one language, you can choose which one the service uses as the source for the translation. |
| Translate to | Select the target languages of the translation. |
| Human translation parameters | |
| Translate attached files | Enable this option to submit the page's file attachments for translation along with the main content. The system adds file attachments directly into the XLIFF translation source as binary data encoded in Base64 format. |
| Priority | Sets the priority of the translation (low, normal or high). |
| Translation deadline | Specifies a deadline date for the translation. |
| Instructions for translators | Here you can enter additional instructions for human translators. |

6. Click **Translate**.

The system adds the new language version of the page. The system initially creates the new page version as a copy of the source language. Once the service completes the translation, you can process the submission to transfer the new content into the appropriate language version of the page. The content tree shows the Waiting for translation status icon (A) next to pages in this state.

Translating multiple pages

To translate more than one page using a single action:

1. Open the **Pages** application.
2. Switch to **Listing** mode.
3. Select the parent of the pages that you wish to translate in the content tree.
4. Switch to the target language using the selector below the content tree.
5. Mark pages for translation using the check boxes next to the listed items.
6. Select the **Translate** action below the page list.
7. Click **OK**.
8. Choose a service and specify the parameters of the translation.
   a. Make sure the configuration is correct in **Settings -> Content -> Translation services**. See Configuring translation services for details on configuring translation services.
   b. (Translation.com service) Check the **Event log** application for incorrect credentials errors.
9. When submitting multiple pages for translation, you can also enable or disable the following options:

| Skip already translated pages | If checked, pages that already exist in the target language are not submitted for translation. Disable this option to overwrite the current content of the pages with the text returned by the translation service. |
| Send all pages within one submission | If enabled, the system includes all listed pages in a single translation submission. Otherwise, separate submissions are created for individual pages. Only applicable when using a human translation service. |
The translation process works the same way as for single items, but the system performs it for all selected pages.

Resubmitting pages sent for translation

The system allows you to resubmit pages already sent for translation (for example, if you edited the page and want to translate the modified version instead).

You can resubmit pages for translation in:

- The Pages application
- The Translations application (standard translation services only)

Resubmitting translations in the Pages application

1. Open the Pages application.
2. Select the modified page in the content tree.
3. Open the Properties -> Languages tab.
4. Click the Translate page ( Española ) action for the language version that you wish to re-submit.
5. Choose a service and specify the parameters of the translation.
6. Click Translate.

The system submits the page for translation just like when creating a new language version. The text returned by the translation service overwrites the original content of the page in the selected language.
Resubmitting translations in the Translations application

1. Open the Translations application.
2. (Optional) If you want to edit the submission before resubmitting it, click Edit (ред) and change the details.
3. If you edited the submission, click Save and Resubmit. Otherwise click Resubmit (представ) in the list of translation submissions.

The system submits the edited page for translation. The new submission replaces the previous one in the submissions list.

Re-translating existing page versions

You can submit pages for translation even if they already exist in the target language. This allows you to use translation services to update the language versions of a page after making changes to its main content.

1. In the Pages application, select the page in the content tree.
2. Open the Properties -> Languages tab.
3. Click the Translate page (пер.) action for the language version that you wish to re-translate.
4. Choose a service and specify the parameters of the translation.
5. Click Translate.

The system submits the page for translation just like when creating a new language version. The text returned by the translation service overwrites the original content of the page in the selected language.

You may also use the Properties -> Languages tab to create new language versions of pages (even if the given page does not exist in the target language).

Translating localization strings using machine translation

The system uses resource strings to localize the names and descriptions of objects, as well as other text in the user interface. You can manage resource strings in the Localization application. See Working with resource strings.

You can use machine services to assist in the translation of localization strings. Multilingual resource strings allow you to dynamically display text in the language selected by the current user, both on the live website and inside the Kentico administration interface.

Requirements:

- The system needs to be configured for multiple website cultures or multiple UI cultures, including all languages that you wish to use in your translations.
- At least one machine translation service must be enabled and configured for the website.

Example

The following example demonstrates how to insert and translate a string into the display name of a category:

1. Open the Categories application.
2. Select a category in the tree and switch to the General tab.
3. Place the cursor into the Display name field and click Localize (пл.)
3. In the **Localization** icon, your website is not probably configured for multiple cultures. See [Setting up multilingual websites](#) and [Setting up a multilingual user interface](#).

4. You also need permissions for localizing strings ([Localize strings permissions](#) for the permissions for the **Localization** module).

**Note**

If you cannot see the **Localization** icon, your website is not probably configured for multiple cultures. See Setting up multilingual websites and Setting up a multilingual user interface.

5. **Click Save & Close.**
   - The **Localize string** dialog shows the content of the string in the default language, and you can fill in a translation for all other available cultures.

6. Place the cursor into the field of a non-default language, and click the icon representing the preferred machine translation service.
The service automatically translates the string's text from the default language.

7. Click **Save & Close** to save the new content of the string.
8. Click **Save** on the category's **General** tab to insert the localization string into the **Display name** field.

Users now see the name of the category translated according to their currently selected language.

You can use the same approach when translating any type of localization string. Machine translation services are also available when editing resource strings directly in the **Localization** application.

### Managing standard (human) translation submissions

Standard (human) translation services use **submission tickets** to keep track of translation tasks. The system automatically creates a new submission whenever a user assigns a page (or batch of pages) for translation via a human service.

To access a list of all translation submissions created on a specific website, open the **Translations** application.

You can manage the listed submissions through the following actions:

- **Edit** - allows you to modify the details of the submission. For example, you can update the submission's deadline date and then resubmit it to the service.
- **Delete** - removes the translation submission. When deleting submissions that have the **Waiting for translation** status, the system
also performs the Cancel submission action.

- **Export all to zip** - allows you to download a zip package containing the translation source data for all pages in the submission. The data is stored in .xliff files using the XLIFF format.
- **Process translations** - inserts the translated content into the corresponding language versions of the pages included in the submission. Only available for submissions that have a completed translation (i.e. those in the Translation ready status). See more in Importing completed human translations.
- **Resubmit to translation service** - resends the translation assignment to the service according to the current settings of the submission and the latest content of the source pages.
- **Cancel submission** - switches the submission to the canceled status. This also informs the translators that they no longer need to finish the translation. The exact functionality performed when canceling a submission depends on the implementation of the used service.

### Importing completed human translations

Because of the waiting period involved in human translation, the system provides an import mechanism that checks the status of translations and retrieves the required data when it is ready. Most human translation services support automatic loading of completed translations.

The translation retrieval process consists of two steps:

1. **Importing the translation data** - loads the XLIFF data of the finished translation from the service and transfers it into the matching submission. This does not affect the website's content.
   - Note that the `<trans-unit>` elements in the imported XLIFF files need to contain the `<target>` child element with the translated text.
2. **Processing the submission** - inserts the translated content into the actual pages. This overwrites the appropriate language version of the pages that were submitted for translation.

### Combining the steps

You can combine both steps of the translation retrieval process by enabling the Automatically import translated submissions setting in Settings > Content -> Translation services. In this case, the system automatically inserts translated content into pages when the data is imported into submissions.

**Warning:** This overwrites pages immediately when a service finishes the translations, without the approval of the content administrators.

To import the content of translated submissions:

1. Open the Translations application.
   - All untranslated submissions are in the Waiting for translation status.
2. Click Update statuses above the list of submissions.
   - This imports all completed translations and switches the corresponding submissions to the Translation ready status.
   - You can automate the translation status updates by enabling and configuring the Translation retrieval scheduled task for your site. With this task running, the system regularly updates all translation submissions according to a predefined time interval.
3. Click Process translations (►) for submissions that are in the Translation ready status.

The system transfers the translated content into the corresponding pages and changes the submission status to Translation imported.

### Manually uploading translation data

The system allows you to directly upload the XLIFF translation data into submissions. You can use this approach if you encounter any problems with the translation retrieval, or if your service does not support automatic loading of finished translations.

1. Open the Translations application.
2. Click Update statuses above the list of submissions.
3. Load the translated data into the submission. You have two options:
   - To upload an .xliff file containing the translated data of a specific page, click Upload translated XLIFF file (.isFile) next to the
matching item in the list of submitted pages.

- If you have the completed translation for the entire submission in a zip archive, upload it by clicking Import all from ZIP.

If the upload is successful, the submission switches to the Translation ready status. You can then process the submission to transfer the translated content into the website's pages.

Developing unique page templates for specific languages

When creating a new language version of a page, you usually only edit the original page on the level of page content, i.e. translate the text on the Page or Form tabs of the Pages application. However, you can also make major changes to the basic layout and design of each culture version by using a different page template. By default, pages share the same page template for all of their language versions.

The following steps demonstrate how to assign a unique page template to a specific language version of a page and then modify it as required.

Prerequisite: You first need to set up multiple cultures for the website.

1. Open the Pages application (the example uses the sample Corporate site).
2. Select the Home page in the content tree and make sure you are in Edit mode.
3. Switch to the Properties -> Template tab.
4. Choose the Each culture version uses its own page template option for the page.
5. Click Save.

This setting is shared between all versions of the page, so it is not important which language is currently selected.

Create the Home page in the chosen language, for example French:

1. Switch to the French language using the selector below the content tree.
2. Select Copy content from another language and English - United States.
3. Click Create page.

The system creates the page and switches you back to the Template tab, but this time for the French language version of the page.
Now you can create a page template for the specific language:

1. Click **Clone template as adhoc**.
   - This creates a separate copy of the current Home page template and assigns it to the French version of the page.
   - You can now change the design of the French page without affecting the other language versions.

   Cloning the template used by the default culture version provides a convenient starting point from which you can quickly make modifications, but it is also possible to select a completely different template if necessary.

2. Switch to the page's **Design** tab.
3. Add an **Editable text** web part into the **Actions zone**.
4. Switch to the **Page** tab. Notice there is an additional editable region.
5. Cut the header text from the bottom region and paste it into the new empty region.
6. Click **Save** to confirm the change.

You can now sign out and view the Home page in the French language. The header text is now aligned on the left and placed above the remaining content.

If you switch to English, the page is unchanged, because it still uses the original template.

This is only a simple example of a modification that can be done when the language version has a separate page template. There are many other possibilities, such as setting different properties for web parts or editing the overall layout of the page.

### Changing the date and time format

Kentico always displays date and time values according to the culture context. The following are examples of a single date and time value in the formats of various cultures:

- **4/17/2015 1:00:00 PM** (en-US)
- **17/04/2015 13:00:00** (en-GB)
- **17.4.2015 13:00:00** (cs-CZ)
- **2015/04/17 13:00:00** (ja-JP)

The system uses two different culture contexts:

- Inside the administration interface, the date and time format depends on the preferred **user interface culture** of each user.
- On the live site, dates are displayed according to the **content culture** that is currently selected by the visitor.

**Note:** Kentico only determines the culture in which dates are displayed. The exact format of date and time values in the given culture is defined by the localization settings of the client operating system.

### Allowing cultures for the administration UI

- **Clone template as adhoc**.
- **Switch to the page's **Design** tab.**
- **Add an **Editable text** web part into the **Actions zone.**
- **Switch to the **Page** tab.** Notice there is an additional editable region.
- **Cut the header text from the bottom region and paste it into the new empty region.**
- **Click **Save** to confirm the change.**

You can now sign out and view the Home page in the French language. The header text is now aligned on the left and placed above the remaining content.

If you switch to English, the page is unchanged, because it still uses the original template.

This is only a simple example of a modification that can be done when the language version has a separate page template. There are many other possibilities, such as setting different properties for web parts or editing the overall layout of the page.

### Changing the date and time format

Kentico always displays date and time values according to the culture context. The following are examples of a single date and time value in the formats of various cultures:

- **4/17/2015 1:00:00 PM** (en-US)
- **17/04/2015 13:00:00** (en-GB)
- **17.4.2015 13:00:00** (cs-CZ)
- **2015/04/17 13:00:00** (ja-JP)

The system uses two different culture contexts:

- Inside the administration interface, the date and time format depends on the preferred **user interface culture** of each user.
- On the live site, dates are displayed according to the **content culture** that is currently selected by the visitor.

**Note:** Kentico only determines the culture in which dates are displayed. The exact format of date and time values in the given culture is defined by the localization settings of the client operating system.
Users with the Global administrator privilege level can configure which cultures are available for the administration interface:

1. Open the Localization application.
2. Select the Cultures tab.
3. Edit (✓) the culture that you wish to use for date and time formats.
4. Select the Is UI culture check box.
5. Click Save.

Users can now select the given culture as their UI culture.

Changing the preferred UI culture

To switch the preferred UI culture for your own user account in Kentico:

1. Open the user menu on the right side of the header anywhere in the Kentico administration interface.

2. Click the culture that you wish to use in the list of available options.

The application reloads the interface in the given culture. All date and time values in the administration interface are now displayed according to the given culture's format.

Example

For example, to change the date and time format to English - United Kingdom (en-GB) for editors in the administration interface:

1. A global administrator needs to allow the English - United Kingdom (en-GB) culture as a UI culture in the Localization application.
2. Individual editors can change their preferred UI culture at any time.